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I - CAN-8 Overview  

This section of the manual is intended for the system administrator and the instructors 

involved in teaching with the lab. While this chapter is an overview of the system, the 

concepts and details addressed will facilitate the understanding of the functions described 

in the other chapters.  

 

It includes: 

• an overview of the system  

• the requirements to use the system  

• installing CAN-8  

• login error messages  

• the roles each user has been assigned through their ID  

• an overview of the functions that each user group can access  

• detailed information about the student interface: the Player.  

How does it Work? 

The CAN-8 system consists of a number of computers (workstations or laptops) 

connected through a local area network (in a lab setting), or through the internet (for 

remote users).  

One of the computers in the network plays a special role: it is the file server (local or 

cloud server). The function of the file server is to store and distribute data such as lesson 

plans created by the instructors as well as the students' answers to their assigned work.  

This centralized file storage means that all data can instantly be accessed by the students 

as well as by the instructor, regardless of their location. No duplication, no setup, and no 

local storage is required on the workstations.  

 

Many of the features of this system are designed to reduce the instructor's workload while 

providing students with a unique customized lesson plan and a simplified submission 

process.  

Easy Access 

• Lesson creation is online: The material is available to the students immediately 

after saving it. Alternatively, the lesson can be prepared beforehand, or reused 

from an earlier class.  

• The students' answers are automatically submitted without having to save, send or 

load them. the instructor can listen to them and provide feedback.  

• Visual display shows the progress of students through the lesson. The instructor 

can select any item, any student, and listen to recorded results for the item.  

• Instructors can talk directly to all the students online or call one student for a 

conversation.  
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• Supervised and online tests can be conducted. Students' recorded answers can be 

marked as part of the test. Scores and class rankings are tabulated by CAN-8 and 

are available for review by the student.  

Organization 

• The curriculum material is organized in a menu system. The student can access as 

many lessons as permitted by the instructor.  

• The students' answers are immediately made available to the instructor for 

evaluation, organized by student, colour coded by type (oral or written answers)  

 
• Students are registered on the system by unique user Id codes. Each student's 

work, progress reports, and assignments are referenced by this Id code. Security 

of the students' work is maintained by the use of passwords.  

Digital Sound 

• Sound is stored and transmitted in a digital format.  

• A dynamic range of 96 decibels means that the quietest sounds are reproduced as 

well as the loudest.  

• Almost all learners find that a foreign language is spoken too fast. Can-8 can also 

optionally allow the student to slow down the sound they hear without pitch 

change to give the student the opportunity to identify the different sounds.  

Flexibility 

• The language lab software can be used by a class of students at a scheduled time 

in a supervised environment.  

• Students can also use the language lab as individuals on their own time, each 

accessing the learning materials and resources independently. No special setup is 

required to prepare the system. The students' work is still available for review by 

an instructor at a later time.  

• Students may work in a remote location that best suits their situation, at the time 

that is most convenient to them.  

Not Just Sound 

• Lessons can include text, graphics and video on the screen as well as sound.  

• Text can be linked to the sound, so that the text is highlighted when sound is 

played. A mouse click on a word in the text will start playing the corresponding 

sound in the audio recording.  
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• Multiple-choice and "fill in the blanks" questions can be used to test 

understanding of listening exercises and provide feedback.  

• The menu system enables easy integration of other programs outside the CAN-8 

system into the course structure in the lab.  

II - Before you start 

CAN-8 VirtuaLab requires a minimum material to function. This section will look at the 

material needed for an end user. The server requirements are as specified in the technical 

guide as they are tended by the IT team of the organization.  

Material requirement 

It is most likely that when working in a lab environment, the workstations have already 

been set to conform with the CAN-8 requirements.  

 

If you are working from your own PC or laptop, you will need to have the following:  

• A PC based workstation or laptop running an operating system supported by 

Microsoft.  

• A speaker and microphone or a headset with integrated microphone.  

• A network card, either hard wired or wireless for access to the Internet  

Most laptops will come with integrated on-board speakers and microphone. Although 

these will be sufficient to run CAN-8, the quality of the sound on these device will vary 

depending on the manufacturer and the environment the recordings are made in.  

Instructors developing new curriculum material should use a higher quality headset or 

stand-alone microphone to ensure a better sound quality and avoid interferences such as 

fan noises that integrated device will pick up.  

 

For PC workstations that do not have integrated microphones, it will be necessary to 

attach one, either stand alone or as part of a headset.  

  

   NOTES 

CAN-8 will not run on your machine if it does not detect a functional speaker 

and/or microphone. An alert message will inform you that you need to attach 

either or both of them.  

... 
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Software requirement 

The minimum software requirement for your workstation is 

• a Windows operating system, recent enough to be still supported by Microsoft,  

• an Internet connection (hard wired or wireless)  

• the version of the CAN-8 software matching the version of your organization's 

server. Your organization will provide you with the correct version. Avoid 

downloading CAN-8 from any other source as it may prevent you from 

connecting to your server.  

• A user ID and password.  

Some software installed on your machine may however interfere and prevent CAN-8 

from running:  

• Your antivirus. It may prevent you from installing and from running CAN-8. If 

that is the case, add a rule in your antivirus settings to allow CAN-8 to run.  

• The Microsoft Windows Defender. When running CAN-8 for the first time, it will 

prompt you to accept to run CAN-8 on your machine. Once you accepted, you 

will not receive this message again. If however you select no by error, you will 

then have to add CAN-8 as a trusted software in the Defender's settings.  

• Your Internet firewall. Most personal routers come with a firewall. The default 

settings on these firewalls allow UDP communication used by CAN-8. If you 

have customized the settings of your own firewall to close the UDP ports, you 

will have to open the range from 17180 to 17190.  

 

  NOTE: 

In most cases, you will not encounter any issues running CAN-8 on your own 

device. If the laptop or PC was given to you by your organization, make sure that 

CAN-8 is installed by the IT technician before taking the machine home. Many 

sites lock these machines and will not let users install any software to prevent 

virus infections. 

 

III - Installing CAN-8 

Once you have verified that you have the proper material, download the CAN-8 

installation file provided by your organization.  

 

The installation of CAN-8 should take only a few minutes. Run the installation file by 

double clicking on it and accept all defaults. A CAN-8 icon will appear on your desktop.  
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IV - Starting CAN-8 

Once the CAN-8 system is installed, attach the headset or microphone and speakers, then 

locate the icon on the desktop.  

Login screen - Signing into CAN-8 

The process of signing on is the same for all users and requires that they know their 

identification code and password.  

Double click on the CAN-8 icon on the desktop.  

 

The login screen may display 2 or 3 fields, depending on the software installation settings 

of your organization.  

 

 

• If the Server field is visible, it will most likely be preset with the name of the 

server you will connect to. Otherwise, type in the information given to you by the 

lab administrator or IT technician.  
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• The USER ID field. Type in the ID you were provided with. This ID is unique 

and personal. Your CAN-8 data and records are kept under that user ID.  

• The Password field. Type in your password. The characters typed are replaced by 

* characters to ensure confidentiality.  

To navigate through this interface:  

• Use the Tab key or the mouse to move the cursor from one field to the other.  

• Use the Backspace key to correct typing errors.  

• Use the Enter key or click on the login icon to sign in.  

Once you have entered the information, the CAN-8 interface will display.  

  NOTES 

The interface will vary slightly depending on the ID you entered which defines your 

role in the system.  

• More information on user roles can be found in this chapter.  

• The instructors' and system supervisor's interface are detailed About Users here.  

• For more information on the student's interface and the Player, read this section.  

 

Errors signing in. 

If you receive the following error message when signing in: 
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Check for spelling mistakes in the USER ID field. Retype your password and try again. If 

the error persists, verify the information with your contact person.  

 

 

Verify the information in the server field. Check for spelling mistakes.  

 

Check your Internet connection.  



 

11 

 

 

The system did not detect a headset, speaker or microphone. Both are required for CAN-8 

to work properly.  If you have attached a headset, check the connection of this device.  

V - Users' Roles.  

Each CAN-8 user is provided with a unique user ID which defines which tool the user 

can access.  

There are 3 types of IDs  

• Student  

• Instructor  

• System supervisor  

This section will detail the privileges of each of these 3 profiles.  

The Different User IDs 

The CAN-8 user IDs system is a hierarchal system. The user with the most privilege is 

the system supervisor. It is followed by the instructors, and then by the students.  
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The System supervisor ID  

Each CAN-8 system comes by default with a system supervisor ID: MASTER.  

 

This ID is unique and cannot be duplicated. It can be shared with other users, but only 

this ID will have the full access to all the CAN-8 functions.  

The Instructor ID  

The instructor ID gives the user access to the system functions that will allow them to use 

CAN-8 as a teaching tool:  

 

Instructors can:  

• Design, create and assign lesson plans  

• Monitor and evaluate their students  

• create activity reports  

The system supervisor can limit the instructor's IDs to the use of certain functions only. 

An instructor's ID can be restricted to only monitor students while others can be limited 

only to curriculum development and others to student registration.  

The Student ID  

Students can only access lessons and tests, submit answers to the works assigned and 

participate to group discussions. BR> 

Their interface, although somewhat similar to the instructor's interface, does not reference 

nor link to any of the tools the instructors have.  

It is therefore impossible for a student to change a lesson plan, view their classmates' 

answers or change their score. 

User   Stud Menu 

And Sub-Menus 

Instructors' Menu 

And Sub-Menus 

System Supervisor's       

Menu 

    And Sub-Menus 

Stud. Yes No No 

Inst.  Yes Yes No 

admin  Yes Yes Yes 
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 Default Menu Access per ID 

Depending on the type of profile the user is registered with, the menu displayed will be 

more or less limited: 

The illustration above is the default menu assignment per user role. These pre-defined 

menus already include certain entries. On a new system, they are the functions such as 

Register Users or Change your Password. These entries types are called Internal 

Command: they link to a system function.  

 

This default menu assignment can be changed to give access to a higher-level menu. 

Instructors can therefore be given access to the Master menu and will be able to see the 

links to functions reserved to the system supervisor, but they will not be permitted to use 

these functions.  

 

This default menu can also be restricted to give only access to a subsection. If the menu is 

organized by languages for example, students can be limited to access only the language 

they are studying. Instructor's menu can be restricted as well to the same subsection.  

   

TIP 

• Since students cannot access the Instructors menu, activities that are in the 

process of being developed should be placed in the instructors' menu until they 

are ready to be published, at which point they can be moved to the students' menu.  

• Tests that are ready but should not be accessed by students can also be placed in 

the instructor's menu until exam time, then they can be added to the students' 

menu the day of. Other tools such as the wait to start option can be used to place a 

test out of reach.  

... 
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System Tools Access per ID 

The table below lists the tools available to administer your system and your users and the 

privilege needed to use them:  

Tool: Available to: 

System Admin ID  Instructor ID  Student ID  

the Player Yes Yes Yes 

The Planner Yes Yes No 

The Tracker Yes Yes No 

Menu Creation Yes No No 

System 

Attributes 

Yes No No 

System Refresh Yes No No 

Import 

Registration 

Yes           Yes** No 

Class Function  Yes Yes No 

Manual Users 

Registration  

            Yes*** Yes No 

Activity Reports Yes Yes No 

 

 ** Since the 2015 09 29 version of CAN-8, instructors can use an import file to create   

their students and classes. They cannot create, delete or edit instructors' profiles not can 

they use it to delete other users than their own students, or delete classes.  

In versions of CAN-8 pre-dating 2015, instructors cannot use import files. 

 

 

*** Note that the System Supervisor can ONLY register instructors using that tool, while 

instructors can only register/edit/delete students.  

  Although the system supervisor cannot register students with this tool, she/he can edit or 

delete their profile.  

 

 

VI - The Player 

The Player is the function that presents a lesson to the students. We also refer to the 

Player as the Student's program. While all CAN-8 users, including the instructors and the 

system supervisor, can access the lessons' Player, the Player is the only function a student 

can access for lessons.  
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This section describes the behavior of existing lessons in the Player, as the students will 

see them. The instructions to author are detailed in the Planner section (planner.pdf)  

 

  NOTE: 

It is not possible to edit a lesson from the Player. When authoring a lesson with 

both the Planner and the Player opened, use the icons on the tabs to identify the 

function displayed on your screen:  

Player tab:  identifiable by its icon  

Planner tab:   identifiable by its icon  

 

Accessing the Player 

To access the Player:  

• Double click on the lesson's title in the main menu.  

A lesson is preceded in the main menu by the icon  

You can also 

• Click on a lesson item in the main menu to select it.  

• Once the lesson is selected (highlighted dark blue), click on the Player 

button  

 

  NOTES: 

• If the item selected is a submenu or a command instead of a lesson item, the 

Player's button is greyed out. These types of items cannot be opened in the Player.  

• To close the player, click on the exit button located at the far-right end of the 

tab bar. (mouse over the illustration above)  

• If you have several Players opened at once, the exit button will close the one that 

is displayed on your screen.  
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You may need to open simultaneously the Player, the Planner and the Tracker of the 

same lesson. To go back to the main menu and select the other function, select the menu 

icon  

 
 

Although the Player's interface will no longer be visible, it is still active and can be 

accessed by clicking on the Player’s tab. It will open exactly where it was last left.  

 
 

Depending on the user’s settings at registration, up to 7 such tabs can be concurrently 

opened. The instructor can toggle from one Player to another, or to a Planner/Tracker, by 

selecting the corresponding tab.  

Player Interface Description. 

The Player is divided in 3 sections:  

• The lesson's menu  

• The work area  

• The button bar  

The Player's Menu 

As mentioned in the preceding chapter, there are two types of menus to consider: 

• The main menu, or interface menu. From this menu, the student will navigate and 

select the lesson assigned by the instructor. This menu is not always identical for 

all students, as the instructors can customize it on a per person basis.  

• The Player's menu or lesson's menu. Once the students select a lesson, the main 

menu is replaced by the lesson's menu. Lessons' menus present only items (or 

exercises) that the students must answer.  

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/playerm.html%23play2
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In a lesson's default practice mode, the lesson's menu is present throughout the entire 

lesson. Students can choose the item they want to display by clicking on it.  

 

The lesson can however be set in sequence or random mode in which case the menu is no 

longer displayed. The lesson is stretched over the entire interface. To select the next items 

in queue, the user must use the Next button.  

 

The illustration below shows a lesson without the menu:  

 

Menu Icons (Item Types) 

The type of the menu displayed (main menu or lesson menu) can easily be differentiated 

by the icons associated to the menu entries. In a lesson menu, each icon represents an 

exercise type. These icons are never present in the main menu. 

               Icon                                          Exercise type                    

 

Introduction Item 

 

Teach Item 

 

Ask/Answer Item 

 

Example Item 

 

Fill in the blanks Item 

 

Multiple-Choice Item 

 

Read Item 

 

Simultaneous Item 

 

Verify Item 

 

Write Item 

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/trackerm.html%23m0003&button_mode
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Menu navigation 

To navigate through the Player's menu:  

• With the mouse; the first click selects the entry (the menu entry background is 

highlighted blue), the second click gives access to the item.  

• with the Next buttons; The user has the choice of using the Next button located in 

the button bar, or the one located in the item bar  

• with the F8 key of the keyboard which will display the next item. 

  NOTES: 

• You cannot navigate through the lesson's menu using the arrow keys.  

• If the lesson is set with timers, the next item will automatically appear.  

• If the Player does not show a lesson menu (the lesson is set to Sequence or 

random), the user can only progress through the lesson using either one of the 2 

Next buttons, or the F8 function key.  

 

The Player's Work Area 

The work area is where the content of the lesson's exercises is displayed, including text, 

images, and audio. It is also divided in 4 main areas as underlined in the illustration 

below:  
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• The Item Bar gives direction to the students related to the item type.  

• The text area, where written instructions are displayed.  

• The graphic area, next to the text area, where images or videos are displayed. If 

no graphic is included in this area, the text area will expand to use this space.  

• The sound graph area is located at the bottom of the work area. Depending on the 

type of item, either one or two volume displays will be displayed.  

The Item Bar 

It is located in the upper part of the work area.  

 

It provides: 

• generic information specific to the type of exercise displayed on the screen and 

indicates what input is required from the student ( Fill in the Blank, Listen then 

Record amongst others). 

These directions are always present.  

• The Next or the Verify Buttons which are located to the right of these 

instructions.  

As soon as the student has provided an answer, the Verify button replaces the 

Next button.  

o If the item required an oral answer, pressing the Verify button will present 

the next screen.  

o If the item was a Fill in the Blanks or a Multiple-Choice item, pressing 

the Verify button will display feedback to its right. The type of feedback 

depends on the lesson's settings and is generic. It will only specify if the 

exercise is correct or incorrect.  

o Some exercises are designed to be automated, and the students' controls 

are locked. In this case, the Next and Verify buttons are greyed out to 

prevent the student from exiting the item before the end of the specified 

time. No feedback will be displayed.  

• A Timer if the lesson is automated. If the exercise includes timers, the main timer 

will appear at the extreme right of this item bar.  

The Text Area 

Any text the instructor has added to the item is displayed in this area. It may include item 

specific instructions and/or a text for the student to read 

• If the item does not include any graphic, this area expands to cover the full work 

area.  

• If the lesson's menu is hidden, the text area will also expand over the menu area.  
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  NOTE 

Text that is part of an exercise cannot be copied or exported from the Player.  

 

The Graphics Area. 

This is where the image or the graphic part of a video included in the exercise is 

displayed. In items that include 2 volume graphs and some text, like in Example items, 

the image may be truncated to allow display room for all the content.  

The Sound Graph Area 

Depending on the type of item displayed, this area may include one, two, or no sound 

graph at all.  

 

 
 

The Sound graph is a graphical display of the sound volume over time.  

 

The height of the green bars in the graph represents the loudness of the sounds in the 

recording. Typically, words or sentences will appear closer to the upper part of the 

display while silences will be represented near the lower part. This provides an easy 

visual way to find the starting points of a word. The student can select a particular 

location to play from by clicking the mouse on the volume display. The system will play 

the sound from that point forward.  

 

The sound graph also includes the audio controls used to record and play sound.  

 

 

These controls are identical to and have the same functions than the controls present in 

top the button bar except for the Speed Control slider which is only present in the sound 

graph.  

This slider allows the student to slow or speed the audio at will without changing the 

pitch of the sound.  
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To slow down the sound, slide the slider thumb to the left.  

 

To speed up the sound, slide the slider thumb to the right.  

 

To go back to the normal speed, slide the slider thumb to the center, where it is pre-

marked.  

 

 

  NOTES ABOUT SLIDERS:  

• If you click on the icons at either side of the slider, the slider thumb will move 

directly to that icon.  

• To gradually increment or slow down the speed of the sounds, move the slider 

thumb to the desired area of the slider.  

• The instructor can disable this function. (see Planner options in the Authoring 

section)  

 

 

  NOTES ABOUT VOLUME GRAPHS: 

• Items requiring Written input only display one sound graph: the instructor's. Other 

items may only show the student's sound graph or show both.  

• If 2 sound graphs are present in an item, the top graph represents the instructor's 

voice sample; the lower graph represents the student's recording. The user may 

click on either one of these graphs to alternate both audios.  

 

The Button Bar and Controls 

The button bar is located above the Player and is part of the main interface.  
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  NOTE: 

Only the buttons that are pertinent to the displayed item are activated. All others 

are greyed out: 

 
 

 

The buttons present in that bar are linked to the buttons in the audio graph, to the top 

menu links and to the keyboard's function keys. Students can use either of or a 

combination of these links.  

 

    Button Keyboard 

shortcut 

Menu bar access 

** 

F2 Controls > Play > Yourself 

This button plays the recording the student had made in the item from the beginning. 

** 

F3 Controls > Record > New Recording or Continue 

Recording. 

This button starts recording the student's voice. Any previous recording is replaced by 

the new recording. However, when accessing this function from the menu bar, the 

student has the choice to redo the recording, or continue a recording. 

** 

F4 Controls > Pause 

Pressing this button in the middle of playing or recording suspends the play or record. 

Pressing the button again resumes.  

 

The buttons above marked with ** are also present on the sound graph and have the 

same functions 
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F5 Controls > Play > Example  

Pressing this button plays the sound recorded for the item in the lesson. In example 

items this plays the example sound that the student is to emulate.  

 

F6 Controls > Play > Introduction 

This button plays the sound recorded for the instructions that apply to a section of a 

lesson (1st "I item" before the exercise). If special instructions have been given to the 

student for an item (in a "C item" for example) these are played instead.  

 

N / A N / A 

Lists the number of messages left by the instructor for this item. If greyed out, no 

message was left. If active, clicking on this icon will bring the links to the messages.  

 

F8 File > Next 

Pressing this button terminates an item and displays the next item. When the item 

menu is already displayed, this button selects the next item in sequence.  

 

N/A File > Back 

Pressing this button terminates an item and displays the preceding completed item.  

 

F9 File > Exit  

This button is present on the top right corner of the interface drag bar. This will log the 

user off CAN-8, even if the student is in a lesson at that time. It cannot be used to exit a 

lesson or an item only. To exit a lesson or an item, the exit button in the tab bar should 

be used instead  

 

N/A N/A 

This button is at the extreme right side of the tab bar. This ends the student's session in 

this lesson. Control returns to the course menu selection system or another tab if one is 

available. 

 

Each one of the buttons described above have 5 possible states, depending on the 

functions available in the item, and of the rights given to the student to access them. The 

table below represents each state for one button only, as they are similar for each button:  
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Button Status Description 

 

Normal Indicates the function is available and can be started 

by clicking on the button. 

 

Hot Indicates the mouse is over the button  

 

Pressed The button remains in this state while its function is 

running. It will return to its normal state as soon as 

it's done, the pause button is pressed or the next item 

is presented. 

 

Greyed If a button function is not available for a certain 

screen, it will be displayed greyed out. 

 

Pressed & 

Greyed 

Indicates that this function is currently running, but 

the control of this button is not available. This is 

usually encountered in an item with a timer and 

where students' controls have been locked.  

 

If the mouse cursor is held over the button for a few seconds, a 

tooltip showing the function of that button will appear below the 

button. 

VII - Item descriptions: 

The following description and visual renditions of the different items apply to items 

placed in the default Practice mode without a timer. The behaviour of each of these items 

may differ when the lesson is placed in test or review modes.  

The Introduction Item  

May include audio or graphic 

Does not present an interface to the student.  

Users cannot input any data  

 

Introduction items are represented in the menu as open or closed folders, depending if 

they are expanded or not. The behaviour of this type of items differs depending on the 

content they include:  

• No content. If the Introduction item is empty, it will divide the lesson plan into 

sections. Selecting it in the menu will either show or hide the exercises it groups.  

• Audio. If some audio is added to the Instruction item, it is used as a section 

marker in the menu, and the audio will be played as soon as the user enters the 

lesson.  
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While navigating though the items below the Introduction item, the student can 

retrieve the Introduction's audio using the Play Introduction button.  

• Image. When an image is added, the instruction remains a section marker and the 

image included becomes the background image for the items that follow.  

o If there is no image included in the next Introduction items, the 

background image will remain though the entire lesson.  

o If the next Introduction item includes an image as well, the image included 

in the first Introduction becomes the background image for that section, 

the image included in the next Introduction will be the background for the 

next section.  

• Audio and image: The Introduction item is now used as a section marker in the 

menu, the audio plays when the student starts the first item in the section and the 

image is used as the background for the section.  

• Text: Because the Introduction item does not display an interface in the Player. 

any text entered in this item will be ignored.  

The Teach Item  

May include audio, text, graphic or video 

Requires no recordable input from students  

 

The teaching item explains a concept or advises the students of the nature of the exercises 

that will follow, and the task expected.  

The sound is played automatically when the student enters the screen.  

As the sound plays, some text might appear highlighted in cyan. This text has been 
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synchronized to a part of the audio; the student can mouse click on the blue synchronized 

words in the text and the sound corresponding to the text will play.  

 

The controls available are pertinent to the item: They are Play, Pause, slow play, and the 

Next button. All other controls (like Record or Type) have been disabled.  

The Example Item  

May include audio, text, graphic or video 

Requires student to: Record a verbal answer  

 

 

This screen includes Two volume displays: the top one shows the instructor's voice and 

the student's own recorded voice is shown below  

The students listen to the instructor's voice and then repeat and record what the instructor 

has said. Then can then compare their own recording with the instructor's.  

In the common case where the lesson is set without timers, the student may record as 

many times as desired. Each time the Record button is pressed, the previous recording is 

replaced with the new one.  

 

It is possible to synchronize the sample audio to the text. As the instructor's voice is 

played, the synchronized words in turn are highlighted in cyan. The student can click on a 

synchronized word as many times as necessary to hear the recording at that word.  
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To add to an existing recording rather than redoing the entire recording, the student can 

select Controls > Record > Continue Recording in the menu bar.  

When the student has achieved a satisfactory recording, pressing Next will submit his/her 

answer and display the next item.  

The Simultaneous Item  

May include audio, text, graphic, video 

Requires student to: Record a verbal answer  

 

The interface of the Simultaneous item is identical to the interface of the Example item 

and includes the same components. 

However, the students cannot listen to the Instructor's sample audio before pressing the 

record button.  



 

28 

 

 

As students press the record button, both the recording and the instructor's recorded audio 

start at the same time. This item type is typically used in simultaneous translation 

exercises.  

 

If the student presses Pause during a recording, both the sample recording and the 

student's recording, can be played separately. 

The student's recording is saved when the student selects Next.  

The Verify Item  

May include text, graphic, video 

Requires student to: Record a verbal answer  

 

This item is similar in appearance to the timer, the student may record as many times as 

desired. Each time the Record button is pressed, the previous recording is replaced with 

the new one. To add to a recording, the student can select Controls > Record > 

Continue Recording in the menu bar.  

The student's recording is stored when the student selects Next.  
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The Read and Record Item  

May include text, graphic, video 

Requires student to: Record a verbal answer  

 

The students are expected to record a response to the instructions given in the text of the 

item.  

Read and record items are usually added to assess the students' ability to pronounce 

words without the aid of an oral example, or for open questions that require a personal 

answer from each student. There is no recorded sound from the instructor in these items, 

only written prompts.  

If the item does not include a timer, the student may record as many times as desired. 

Each time the Record button is pressed, the previous recording is replaced with the new 

one.  

 

To add to a recording, the student can select Controls > Record > Continue 

Recording in the menu bar.  

When the students have achieved a satisfactory recording, they can press Next to submit 

their recording to the instructor and move to the next item.  

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/playerm.html%23play38
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The Ask Item  

May include audio, text, graphic, video 

Requires student to: Record a verbal answer  

 

 

The ask item includes a verbal question and requires the student to record the response.  

 

There is no volume display of the instructor's voice for the student. The instructor's 

question can be re-played using the Example button.  

 

Students can see their own voice displayed on the volume graph and can replay and re-

record as desired.  

 

This item is used to assess a student's ability to understand a spoken question and to 

prepare a response without the aid of a recorded example.  

 

If the item does not include a timer, the student may record as many times as desired. 

Each time the Record button is pressed, the previous recording is replaced with the new 

one.  
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To add to a recording, the student can select Controls > Record > Continue 

Recording in the menu bar.  

When the students have achieved a satisfactory recording, they can press Next to submit 

their recording to the instructor and move to the next item.  

The Multiple-Choice Item  

May include audio text, graphic, video 

Requires student to: Select an answer  

 

When the students enter a Multiple-Choice Item, the instructors recorded audio is played.  

 

The student is then required to Pick an answer from the possible choices, which are 

numbered from 1 to 8.  

To select an answer, the students can click on the answer or enter the number of the 

answer with the keyboard's numeric key.  

 

The Instructor's audio can be replayed with the Example button or by clicking on the 

volume display.  
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As soon as the students select an answer, the NEXT button is replaced by the CHECK 

button in the item bar.  

 

 
 

 
 

The students then click on the CHECK icon to submit their answer and proceed to the 

next item. In the default practice mode, unless the instructor changed the Planner's 

settings, the system will provide feedback on the answer. The students will have to select 

the next button to advance to the next item.  

Full feedback 

 

By default, when a lesson is in practice mode, full feedback is provided for Multiple-

Choice items. The feedback will appear when the Check button is pressed. It provides the 

state of the answer (correct/incorrect) and shows the correct answer.  

In this illustration, the student chose a wrong answer. The selected answer is displayed on 

red background whereas the correct one is displayed on green background.  

The student can review the feedback and select the Next button to proceed with the next 

item.  

Partial feedback 

 

Partial feedback will only display the status of the answer (correct or incorrect) in the 

item bar but will not show the correct answer.  

The students can review their answer and select the Next button to proceed with the next 

item.  

No feedback 

When the instructor sets a lesson in test mode, the feedback is automatically removed if a 

numeric mark is assigned to the item. The next button is active in the item bar, but no 

information regarding the correctness of the answer is given.  
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The student proceeds to the next item as soon as the Next button is selected.  

The Fill in the Blanks Item  

May include audio text, graphic, video 

Requires student to: type an answer in the blank spaces provided.  

 

 
The student is required to type in the missing word or words in the blank space(s) on the 

screen. There can be more than one blank space per screen. Blank spaces are displayed as 

boxes with a dark background (as illustrated). The text cursor blinks in the box where the 

next answer should start.  

In some lessons, a Virtual Keyboard might come up if it is necessary to use characters not 

available on the physical keyboard.  

When one area (or blank space) is filled in, the cursor will automatically move to the 

next input area of the screen. 

The student can use the backspace key to move back to re-type a letter to fix an error. 

The tab key can be used to move forward to the next blank space.  

Letters cannot be deleted; they must be typed over.  

The mouse can be used to position the text cursor by clicking on the new location. 
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When the student is satisfied with the answer and press the Check button, the answer 

becomes available to the instructor. If the lesson is set to its default settings, feedback is 

provided in the in the item bar.  

Full feedback 

 

With the default settings in practice mode, full feedback is provided when the Check 

button is pressed.  

The correct answer(s) are shown in a green field under the incorrect or missing answers, 

as shown below:  

 

  NOTES: 

• The above example shows 2 blanks, 1 of which was answered incorrectly.  

• The Correction is shown in green, underneath the blanks containing an error only.  

... 

Partial feedback 

 

Partial feedback will only display the status of the answer (correct or incorrect) in the 

item bar but will not show the correct answer.  

The students can review their answer and select the Next button to proceed with the next 

item.  

No feedback 

When the instructor sets a lesson in test mode, the feedback is automatically removed if a 

numeric mark is assigned to the item. The next button is active in the item bar, but no 

information regarding the correctness of the answer is given.  

The student proceeds to the next item as soon as the Next button is selected.  
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The Writing or Dictation Item  

May include audio, graphic, video 

Requires student to: Type a written answer  

 

The Writing or Dictation item presents either a verbal instruction, an oral open question 

or a dictation to transcribe. The student must type the answer. An image can be added as 

part of the information, but no text from the instructor will be displayed in these items.  

 

In some lessons, a Virtual Keyboard might come up when an item requiring text input is 

entered if the instructor set it so.  

 

The student can print a copy of the text they have created, or save it to file, by selecting 

the Print or Export option from the file menu.  
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The system does not provide feedback for write items.  

The answer will be available to the instructor for evaluation as soon as the student selects 

the Next button and the next item will appear.  

The Conversation Item 

The conversation item is not visible at all from the Player's menu as it does not present an 

interface to the student. Only the item that follows it and is paired with shows in the 

menu. This item can only be paired with and Example or a Verify item and is meant to 

provide the instructor with an additional voice input for these items.  

 

If for example the lesson was created with a Conversation item named C ITEM followed 

by a Verify item titled V ITEM, the lesson's menu will only display V ITEM. As the 

student selects V ITEM in the menu, the Player displays the interface for V ITEM, 

however the first audio that is played is the audio included in C ITEM.  

 

More details on Conversation items can be found in the Planner section.  

VIII - Keyboards and Characters 

In items that require typed input, students in most cases will use the regular keys on the 

keyboard.  

In some lessons however, the text required might include characters that are not on the 

keyboard.  

 

If the settings of the workstations allow for more than one language in the input locales, 

then switching languages in the bottom right corner of the screen will allow to type in 

another language with different characters using the same keyboard.  

In many cases, the answer must be composed in a language that does not have standard 

keys available on the keyboard. Character variants can still be typed using the following 

2 options:  

Character variants using the regular keyboard 

Certain languages require accentuated characters or a few character variants.  
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If only a few variations of the keyboard's characters are required, the student can right 

click on the typed character that needs to be accentuated. This will bring a pop-up box 

with all the available accents or variants for that character. The student can click on the 

appropriate one.  

Alternatively, the student can select a character variant by first typing the root character 

and then pressing the CTRL and A keys. The typed character will change for a variant. 

By repeatedly pressing CTRL A, the student can cycle through all the possible accents or 

variants for that character.  

Virtual Keyboards 

Sometimes the instructor will have to include a virtual keyboard in the lesson, either 

because of its specific layout or because the characters required to answer the question 

are too different from the computer's keyboard characters.  

 

This on-screen keyboard will only show in items requiring written input, such as Fill in 

the Blank items or Write and Dictation items. They will not be displayed in items that do 

not require typed input.  

The Instructor can set the virtual keyboard to be optional.  



 

38 

 

 

This allows the student to toggle between the system's keyboard and the on-screen 

keyboard and select characters from either one.  

• To type with the virtual Keyboard, the student needs to click once on its interface 

to activate it. Once activated, the virtual Keyboard is fully visible and linked to 

the physical keyboard. The student can then either click on the on-screen 

characters or press the corresponding key on the system's physical keyboard. 

• To use the system's keyboard, the student needs to disactivate the virtual 

keyboard. This is done by clicking anywhere in the text area. The keyboard is de-

selected and appears semi-transparent on the screen. The student will then type in 

the default language the computer's keyboard is set to. 

In cases where the defined (on-screen) keyboard is non-optional, any character typed 

with the computer's keyboard will come out as the corresponding character on the on-

screen keyboard. The student can also click on each key of the on-screen keyboard to 

enter the character.  
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Combinations of the Shift, Alt, and Ctrl keys can be used to select from up to eight 

different levels of layout in one keyboard.  

 

A mouse click on one of these three keys locks the key down so that the mouse can be 

used to select another key. The Caps Lock key is used to lock whatever combination of 

shift keys is currently selected. Pressing Caps Lock again will unlock the shift keys.  

 

 

The student can right click on a key of the virtual keyboard to display character variants 

then select it with a left click.  

IX - The SV Phone 

Students cannot use the Phone function to call another student, nor can they directly 

initiate a phone conversation with the instructor; they can however send a request for 

assistance at any time during the lesson.  

Call request 

Sending a request for assistance can be done using any of the following:  

•  

select Help -> Call Instructor from the menu bar;  

• press the F12 function key;  

The instructor will receive a visual request in the Tracker of the lesson the student sent it 

from and will have to initiate the call to begin the conversation.  

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/trackerm.html%23t0012&button_mon
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Receiving a Call 

 

 

When the instructor initiates the call, the phone interface appears on the student's screen:  

• The volume display at the bottom indicates the loudness of the student's voice. 

The volume is controlled using the Microsoft Volume Control tool.  

• The identity of the caller is displayed under the volume display.  

• The conversation is terminated when either the instructor or the student presses 

Exit.  

 

 

The instructor may also decide to make an announcement to all students simultaneously 

using the Phone, in which case the phone window appears on each student's station  

• There is no volume graph shown as the students cannot record their voice  

• Students cannot end the announcement nor exit the window. It will disappear on 

its own as soon as the instructor stops the announcement.  

• The phone window however can be moved around the screen if its location 

prevents an item from showing.  
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X - Messages from Instructor 

Sometimes, the instructor when correcting an item will want to leave some oral feedback 

to the student. It might be a general comment on the recording done, or a request for the 

exercise to be redone. The steps to leave a message to a student are described in the 

Tracker chapter of this manual.  

 

The student receives an alert when signing in CAN-8. This Alert lists the messages 

received since the last CAN-8 session. If the student has a schedule test or lesson, this 

alert can be closed by selecting Cancel or exiting the alert, and the student can access the 

scheduled lesson, but this alert will come up every time the student closes a lesson and 

come back to the main interface, or signs on again, until all the messages are read. 

 

The student can: 

• click on any of the message from that list and the item where the message was left 

will open in the order selected.  

• press Start and the items will open in the order listed.  

• select Cancel and the alert will close until the next time the student is in the main 

interface.  

If the student selects one of these links, the item where the message was left will open 

and the last message will play automatically.  

 

Each item in every lessons of the system can keep up to 99 messages for the user. The 
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number of messages in an item are indicated in the message button: To retrieve 

previous messages, the student can click on this button. 

 

The window that opens list all the messages left in that item, from the most recent to the 

most ancient. Each of these messages can be played by clicking on the link.  

When leaving a message, the instructor has the option to force the student to re-do the 

item by preventing the student from proceeding to another item. If the student attempts to 

proceed to the next item by clicking the NEXT button, the following message will appear 

in the item bar.  

 

 

XI - Timers 

Each item in a lesson can be timed, independently if they require an input of the students 

or not.  

You may also encounter timed items where all the controls are locked (greyed out). 

Playing, recording audio, and exiting an item to move to the next one is entirely 

controlled by the system, at the time defined by the instructor who created the lesson.  
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Time limits can be set for the presentation of the question (total time spent in the item) 

and for the student's answer (Maximum time to submit an answer). 

 

The Presentation timer, or preparation timer, is located in the Item's bar while the 

answer's timer is located in the volume graph or the lower part of the text area depending 

on the item type.  

 

As soon as the student opens the item, the counters will display the maximum limit 

allowed and will start counting down.  

  NOTE: 

When preparing a lesson with timers that lock the controls or limits the time to 

submit an answer, the instructor should always add a Teach item at the beginning 

to advise the student of the upcoming limits.  

Preparation Timer 

 
 

The first timer activated when the item is entered is the Preparation (Time) clock.  
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Presentation time allows extra time for the student to read text, listen to the recorded 

sound, or think of the answer. It is located on the item bar.  

 

When the presentation time limit is up, the student recording timer automatically begins 

if the item requires an audio answer and will terminate the item when the time limit has 

been reached. For dictation, multiple choice or fill-in items the item is terminated as if the 

Next key had been pressed.  

  NOTE: 

If the controls have not been locked, the students can re-do their recordings as 

many times as they wish during that period or terminate the answer before the end 

of the count down. But if the controls are locked, the system will control the 

buttons and will terminate the item when the counter reaches 00:00.  

 

Recording Timer  

 

The recording timer is located in the student's audio graph 

This timer shows and counts down the maximum time allowed for this recording. It is 

therefore found only in items where recorded answers are required. 

When this counter reaches 00:00, the item is terminated as if the Next key had been 

pressed.  

  NOTES: 

• Some items with timers are partially automated. Either one, or both of the timers 

might be present, but some of the function buttons, like Record or next are active.  

• In other cases, the item will be fully automated. All buttons are greyed out and the 

students must wait to record or leave the item. In that case, the presentation timer 

includes both the preparation time and the recording time. Instructors are advised 

to leave a prompt in their own recording advising the students their recording time 

is about to start.  

• The Timers' behaviour is different depending on the type of item it is placed in. 

Further details related to item specific timers can be found in the Item description 

section.  

... 
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XII - Practice and Test Modes 

The mode of the lesson will impact how the lesson behaves in the Player and which 

information is made available to the student.  

The lesson can be set in:  

Practice mode: 

 

Unless otherwise specified, the lesson is treated as a drill and practice.  

In this mode, the menus indicate items that have been previously answered by showing 

them in green.  

Multiple-Choice and Fill-in questions may give the correct answer as the student moves 

on to the next item. If such is the case, the item's title in the tree menu is displayed in 

green if correct and in red if not.  

Items that are in black are items for which no answer has been recorded yet.  

If marks have been assigned to the items, the marks will show in the menu.  

Pre-Test mode: 

 

In that mode, the students are prevented from entering the activity. They must remain 

with this message until the test starts.  
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  NOTES: 

• The student should not attempt to exit this window or the lesson. As soon as the 

instructor changes the lesson mode to Start Test, the message box will disappear, 

and the test will start.  

• Students who exit this window might delay the start of the test or be locked out of 

the test when the instructor starts it, depending on the start option selected.  

... 

Test mode: 

There are several tests settings. Depending on which one the instructor chose, the display 

will vary, and so will the information:  

1 – with menu 

  

 

• The student can select any item from the menu in any order.  

• Questions where an answer has been submitted are in green font. Unanswered 

questions are in black font.  

• No visual clue is given that would indicate if the answer is correct or incorrect.  

• The available score for each question is also shown in the menu. This may help 

the students decide which item to answer first.  
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2 - in sequence with back button disabled 

 

When in sequence mode, the tree menu is hidden. Only the work area and control buttons 

are visible. answered items cannot be redone.  

3 - in random mode  

The student must answer each item and move to the next one without the possibility to 

go back to a previous item.  

The questions are randomized within a section (between 2 introduction items). If the 

student selects to skip a question, the item will be presented again until all the questions 

from that section are answered. The test will then continue to the next section.  

 

  NOTES: 

• With these settings, the treeview is hidden and the Back button disabled. The 

students have to take the test in the order given.  

• If the students exit then re-enter the test they are presented with the first non-

answered item.  

• Answers previously recorded cannot be re-recorded.  

• Available marks are not shown.  
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4 - automated with students' controls disabled.  

 

When a test is fully automated, all buttons are disabled; the student will be brought from 

item to item without possible interaction with the system. The recording will start 

automatically, and the student will be prevented from either going forward, backwards or 

listening to instructions a second time.  

  NOTES: 

• When re-entering this test, the student is presented with the first NON-

ANSWERED item.  

• Answers previously recorded cannot be redone.  

... 

Review mode: 

The Review Mode Is the last step in the test sequence. This mode prevents students from 

answering any more question, or from changing a previously submitted answer. It allows 

them to see their answers and the marks for each answered question. 
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When the student selects an item, the answer that was entered during the test is displayed. 

However, the student cannot change the answer (or answer one that was skipped). If 

attempting to do so, they will be advised that it is no longer possible.  

 

The review mode always displays the menu, even if the test was in sequence or random 

mode. The students can see the marks per items. The menu also indicates incorrect items 

in red, correct in green.  

Final Mark: 

The instructor has the option to send the results of the test to the students after marking it, 

or in the case of a Multiple-Choice test, right away. 

 

Final marks are displayed while the students are in review mode, or when the students 

enter the lesson next. 

Final marks are not displayed when the activity is in test mode.  

The score alert indicates the student's personal score, rank in the class for that test, the 

class average, and highest mark in that class. They do not see the other student's score.  

 

If the instructor chooses not to send the test results, the students can still access their own  
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score from the top menu  

 
 

The information displayed only shows their personal score for that test.  

 
 

 

 

 

This concludes the overview chapter of this reference manual. Other 

chapters are available as follow: 

• For information on creating teaching materials, see planner.pdf 

• For information on monitoring the students and evaluating their 

answers, see Tracker.pdf 

• To groups students and record their discussion: babilon.pdf 

• Admin.pdf details the tools available to the system supervisor.   

For technical or software support, renewal of your maintenance agreement or 

information about its status: 

416 968 7155 ext. 502 Toll Free in North America: 

 1 855 305 9937 ext. 502 support@can8.com 


